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Artifact Rationale
Per the Veteran-focused Integrated Process (VIP) Guide, the User’s Guide is required to be completed prior to Critical Decision Point #2 (CD2), with the expectation that it will be updated as needed. A User Guide is a technical communication document intended to give assistance to people using a particular system, such as VistA end users. It is usually written by a technical writer, although it can also be written by programmers, product or project managers, or other technical staff. Most user guides contain both a written guide and the associated images. In the case of computer applications, it is usual to include screenshots of the human-machine interfaces, and hardware manuals often include clear, simplified diagrams. The language used is matched to the intended audience, with jargon kept to a minimum or explained thoroughly. The User Guide is a mandatory, build-level document, and should be updated to reflect the contents of the most recently deployed build. The sections documented herein are required if applicable to your product.
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[bookmark: _Toc29477060]Introduction
The Care Coordination (CC) Standardized Episodes of Care (SEOC) is a reference database for managing care bundles for use by Veterans Information Systems and Technology Architecture (VistA) and other Department of Veterans Affairs (VA) systems. Services are grouped together within the SEOC system into bundles so that clinicians can add these bundles to patients consult records in a standardized fashion, reducing the amount of time spent manually entering consult instructions, and providing uniformity among the patient records and across facilities for how patient care is prescribed for similar complaints.
These bundles group together one or more services that are preselected for different specialties to be added to the consult records. In addition, the clinician is provided with information regarding prescribing rules and preauthorization requirements, so they can make the most informed decisions regarding patient care.
Additionally, SEOC data will be accessible outside of the VistA/Computerized Patient Record System (CPRS) system so that users of downstream applications will be accessing the centralized data, and SEOC descriptions, reducing the chances of disconnects.
[bookmark: _Toc29477061]Purpose
The purpose of this document is to provide instruction for utilizing the SEOC application to standardize and streamline consult management for Community Care.
[bookmark: _Toc29477062]Document Orientation
The Care Coordination (CC) Standardized Episodes of Care (SEOC) v1.10 Administrative User Guide will provide explanations of each screen and of all user interface options within the context of an easy to understand demonstration data scenario. 
This document is also designed to provide the user with screen-by-screen “how to” information on the usage of CC SEOC.
[bookmark: _Toc29477063]Organization of the Manual
[bookmark: _Hlk508808487]Section 1: Introduction
The Introduction section provides the purpose of this manual, an overview of the SEOC software, an overview of the software used, project references, contact information for the user to seek additional information, and an acronyms and abbreviations list for this manual.
Section 2: System Summary
The System Summary section provides a graphical representation of the equipment, communication, and networks used by the system, user access levels, how the software will be accessed, and contingencies and alternative modes of operation.


Section 3: Getting Started
Information for the Getting Started section provides a general walk-through of the system from initiation through exit, enabling the user to understand the sequence and flow of the system.
Section 4: Using the Software
This section gives the user the “how to” information to use SEOC, including many step-by-step procedures.
Section 5: Troubleshooting
This section provides troubleshooting for the SEOC user.
Section 6: Acronyms and Abbreviations
This section provides a list of acronyms and abbreviations found in this document.
[bookmark: _Toc29477064]Assumptions
This guide was written with the following assumed experience/skills of the audience:
User has Google Chrome and/or Internet Explorer 11 installed on their machine.
Please note that SEOC is not fully 508 compliant in Microsoft Edge, so the VA will continue to support 508 in only Google Chrome and Internet Explorer 11.
The SEOC user has basic knowledge of the SEOC system (such as the use of commands, menu options, and navigation tools).
The SEOC user has been provided the appropriate active roles, menus, and security keys required for the SEOC User Interface (UI), as defined below in User Roles. 
The SEOC user is using SEOC to perform their daily consult creation workflow and perform the required SEOC functions.
The SEOC user has validated access to the SEOC UI.
The SEOC user has been provided training on the SEOC UI and has reviewed the User Guide.
SEOC Content Authors: The SEOC Content Authors are responsible for creating and update the content within the SEOC repository using the SEOC UI. These users are required to VA access rights and privileges and will sign on to the SEOC application using their SSOI credentials (typically their PIV and access code).
CPRS Clinicians that are responsible for documenting patient consult records. These clinicians utilize the SEOC content as part of their daily consult creation workflow such that they will add a SEOC bundle to the patient consult record which will provide for a standardized documentation and care plan approach across the VA for these consults.
[bookmark: _Toc29477065]Coordination
One Consult - Consult Toolbox 1.9.02 and above and the HealthShare Referral Manager (HSRM) depend on the availability of the SEOC System. Consult Toolbox 1.9.02 requires active SEOCs whereas HSRM requires active and discontinued SEOCs. Coordination between the One Consult – Consult Toolbox, HSRM, and SEOC team is necessary with any updates to SEOC. 
[bookmark: _Toc29477066]Disclaimers
[bookmark: _Toc29477067]Software Disclaimer
This software was developed at the Department of Veterans Affairs (VA) by employees of the Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the United States Code this software is not subject to copyright protection and is in the public domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We would appreciate acknowledgement if the software is used. This software can be redistributed and/or modified freely provided that any derivative works bear some notice that they are derived from it, and any modified versions bear some notice that they have been modified.
[bookmark: _Toc29477068]Documentation Disclaimer
The appearance of external hyperlink references in this manual does not constitute endorsement by the Department of Veterans Affairs (VA) of this Web site or the information, products, or services contained therein. The VA does not exercise any editorial control over the information you may find at these locations. Such links are provided and are consistent with the stated purpose of the VA.
[bookmark: _Toc29477069]Documentation Conventions
This manual uses several methods to highlight different aspects of the material.
Table 1. Documentation Symbols and Descriptions
	Symbol
	Description

	[image: ]
	CAUTION: Used to caution the reader to take special notice of critical information.


[bookmark: ColumnTitle_02]Notes are used to inform the reader of general information including references to additional reading material.
[bookmark: _Toc29477070]References and Resources
[bookmark: _Toc408993568][bookmark: _Toc408996936][bookmark: _Toc408996969][bookmark: _Toc408999049]Readers who wish to learn more about CPRS and CC SEOC should consult the VA Software Document Library.
[bookmark: _Toc29477071]National Service Desk and Organizational Contacts
For issues related to the CC SEOC that cannot be resolved by this manual or the site administrator, please contact the National Service Desk at 855-NSD-HELP (673-4357).
[bookmark: _Toc29477072]System Summary
There was an immediate need to provide clinicians the ability to quickly and consistently add care bundles to a patient’s consult record within VistA. SEOC provides this feature for a higher level of uniformity in patient care, easier access to appropriate services, based on initial diagnoses, and the ability to better control care costs. SEOC allows clinicians to enhance the coordination of care for the Veteran.
The system contains SEOCs, or care bundles, that clinicians or other designated individuals can assign to VA patients. These bundles allow for the consistent use of procedures when certain conditions are diagnosed. This consistency allows the VA to effectively manage patient care and provides easier traceability.
[bookmark: _Toc29477073]System Configuration
The SEOC System is designed to be a simple reference database with a supporting SEOC API and User Interface (UI) layer. The SEOC system comprises three application tiers as shown below.
[bookmark: _Ref500326578][bookmark: _Toc512420962][bookmark: _Toc29477124]Figure 1: Overview of SEOC System
[image: ]
The first tier is the Data Tier. This tier contains SEOC data. SEOC uses Microsoft Structured Query Language (SQL) Server is the database. SEOC data consists of reference data, such as SEOC name, associated procedures, associated Current Procedural Terminology (CPT) codes, procedure durations, etc. Additionally, user role information is maintained within the tables, but no passwords or other credentials are stored. No PHI or PII is stored in the database. SEOC data is associated with patient data in the VistA consult record.
The second tier is the Abstraction Tier. This tier acts as the data broker for the SEOC system. It is a REST Application Programming Interface (API), built as a microservice hosted on container infrastructure (Docker Container). The API itself is built on the Spring MVC framework. The API receives web API calls that are forwarded to the database appropriately. Consuming applications are able to query the SEOC system through the SEOC REST API but will not be able to perform updated operations. The SEOC UI uses certificates to authenticate with the SEOC REST API to allow data modification within the SEOC system by authenticated users. Users are authenticated using SSOI. Additionally, a VistA/MUMPS patch is created to insert the SEOC associations into File # 123.
The third and final tier is the Presentation Tier. This tier consists of the SEOC UI, which provides a user interface for approved, authenticated users to maintain the SEOC collection. This application is a web application built as a microservice hosted on container infrastructure (Docker Container). The UI is built using the React.js JavaScript framework for web applications. 
[bookmark: _Toc29477074]Data Flows
[bookmark: _Toc29477125]Figure 2: SEOC Data Flow Diagram
[image: ]
[bookmark: _Toc29477075]User Access Levels
SEOC user profiles comprise of the following “types of users”:
SEOC Content Authors: The SEOC Content Authors are responsible for creating and update the content within the SEOC repository using the SEOC UI. These users are required to VA access rights and privileges and will sign on to the SEOC application using their SSOI credentials (typically their PIV and access code).
CPRS Clinicians that are responsible for documenting patient consult records. These clinicians utilize the SEOC content as part of their daily consult creation workflow such that they will add a SEOC bundle to the patient consult record which will provide for a standardized documentation and care plan approach across the VA for these consults.
SEOC data is also accessible to other external consumers in the future (in addition to CPRS users). The SEOC API is a RESTFul API that other (to be determined) users will have access to use.
[bookmark: _Toc29477076]Continuity of Operation
The SEOC system is maintained by Enterprise Operations (EO). The continuity of operations is managed by EO. 
[bookmark: _Toc29477077]Getting Started
This section provides a general walkthrough of CC SEOC from initiation through exit. 
[bookmark: _Toc29477078]Logging On
CC SEOC is accessed using the VA Single Sign-On Internal (SSOi) log in using the following URL: https://seoc.va.gov/
[bookmark: _Toc29477126]Figure 3: VA Single Sign-On for SEOC
[image: ]
After 15 minutes of inactivity the system will automatically log you out. After 13 minutes of inactivity the system will prompt you to extend your session.
[bookmark: _Toc29477127]Figure 4: Session Timeout Warning
[image: ]
The current session is refreshed when a Request is Made to the API, a SEOC is updated, a Search or Filter is performed, or any fields for a User or Billing Code are updated.
[bookmark: _Toc29477079]System Menu
The Standardized Episodes of Care home page offers several features: Filter by Status, Filter by Name, Export, Manage, Edit Disclaimer, View Selected SEOC, and Draft New SEOC. The home page also displays the user name at the top right of the page.
[bookmark: _Toc29477128]Figure 5: Standardized Episodes of Care Home Page
[image: ]
	[image: ]
	CAUTION: To view the list of SEOCs using a keyboard interface with assistive technology, you will need to use the “Tab” key to navigate through the list..


Standardized Episodes of Care table fields:
Service Line – A broad category of care for the services and procedures included which is intended to be used to group and filter SEOCs for easier accessibility. A standardized three-letter abbreviation of the service line is included at the beginning of the SEOC ID.
SEOC Name – A unique title that categorizes a SEOC by specialty/subspecialty or area of clinical practice.
Version – The version number of the SEOC. The version number is formatted A.B.C where the first digit will be 1, the second digit is the number of published SEOCs in the same Category of Care when a new SEOC is activated, and the third digit is a serialized revision number.
Effective Date –The date the SEOC status was made from In-Progress to Active.
End Date –The date the SEOC status was discontinued.
Status –The SEOC statuses are as follows: 
Active: When a SEOC is Active, it will be available for all end users (e.g. API users, scheduling, payment, and auditing purposes). 
Date Hold: When the SEOC status is Date Hold, it is pending and set for activation on a designated future date. This status is only available for SEOC Administrative users for editing purposes. 
Discontinued: When a SEOC is Discontinued, read-only users will not have access to the discontinued SEOC in the SEOC Database and or the scheduling interface. However, the discontinued version will still be available for payment and auditing purposes. Discontinued SEOCs will remain in the SEOC database for up to six (6) years in the central repository.
In-Progress: The SEOC is available for editing purposes by the Administrators and Authors prior to activation. These SEOCs will not be available via SEOC Database API. 
[bookmark: _Toc29477080]Changing User ID and Password
If you need to change your user password, you will need to contact your local PIV office.
[bookmark: _Toc29477081]Exit System
If you are finished working, log out of VA Single Sign-On and close any secure sessions that may still be open by clicking the Logout button.
[bookmark: _Toc29477082]Using the Software
The CC SEOC provides user functionality for the following items: 
Manage Users
Filtering Users
Filter Users by Role
Filter Users by User Name or VA Network ID
Delete a Selected User
Edit a Selected User
Add a New User
Exporting Data
Export the SEOC Data to a JSON File
Export the VA PreCert Webpage to a JSON Fil
Manage Billing Codes
Search for a Billing Code
Deleting Billing Codes
Editing Billing Codes
Return to SEOC List
Exit Maintenance Mode
Extend the Current Session
Edit the General Disclaimer
Deactivate the General Disclaimer
Viewing SEOCs
View a Selected SEOC
Search for a SEOC by Name
Sort SEOCs Alphabetically by Name
Filter SEOCs by Status
Discontinue a SEOC
Print a SEOC
Invalid Characters
Show Invalid Characters
Fix Invalid Characters
Track Version Changes
Draft a New SEOC
Edit an In-Progress SEOC
Activate an In-Progress SEOC
Delete an In-Progress SEOC
Pending Revisions
Create a Revision
Activate a Revision
Revert a Date Hold SEOC Back to In-Progress


[bookmark: _Toc29477083]Manage Users
The SEOC Admin UI supports the following user roles:
Viewer: Read-Only. This user will only see Active or Discontinued SEOCs on the Home Page. They are only able to View, Print, or Track Version Changes on selected SEOCs. This user will not see Provider Codes on the View SEOC Page, the Track Changes Page, and the Print SEOC Page. Also, by default the SEOC List will show only Active SEOCs for this user.
Analyst: Has all of the privileges of the Viewer but can also view Date Hold SEOCs. They can also Export SEOC Data or Export VA PreCert Webpage Data to a JSON file.
· Author: Has all of the privileges of the Viewer but can also view In-Progress or Date Hold SEOCs. They can also Draft a New SEOC, Create Pending Revisions, Delete SEOCs, or Edit SEOCs. This user will see Provider Codes on the View SEOC Page, the Track Changes Page, and the Print SEOC Page.
Publisher: Has all of the privileges of the Author but can also Activate or Discontinue SEOCs, Export SEOC Data or Export VA PreCert Webpage Data to a JSON file, and Edit the General Disclaimer.
Administrator: Has all of the privileges of the Publisher, but can also open the User Management page, Add New Users, Edit Users, or Delete Users. However, an Administrator can’t modify their own privileges. This ensures there will always be at least one Administrator.
To manage users for the SEOC Admin UI, follow the steps listed below:
As an Administrator on the SEOC Admin home page, select Manage Users from the Manage Menu. The User Management window displays.
[bookmark: _Toc29477129]Figure 6: User Management
[image: ]
[bookmark: _Toc29477084]Filtering Users
[bookmark: _Toc24637014][bookmark: _Toc29477085]Filter Users by Role
To filter the list of users in SEOC by role, follow the steps listed below:
1. From the SEOC Admin home page, click Manage Users. The User Management window displays.
1. From the Filter by Role drop-down menu, select All, Viewer, Analyst, Author, Publisher, or Administrator to filter the list of users by role. The list refreshes to display the role selected.
[bookmark: _Toc16600021][bookmark: _Toc24637520][bookmark: _Toc29477130]Figure 7: Filter Users by Role
[image: ]
[bookmark: _Toc29477086]Filter Users by User Name or VA Network ID
To filter the list of users in SEOC by user name or VA network ID, follow the steps listed below
1. From the SEOC Admin home page, click Manage Users. The User Management window displays.
1. From the User Management page, enter the User Name or VA Network ID of the user in the Filter by Name (contains) field. 
[bookmark: _Toc16600022][bookmark: _Toc24637521][bookmark: _Toc29477131]Figure 8: User Search Field
[image: ]
1. Click the Search button. The Search User Results display.
[bookmark: _Toc16600023][bookmark: _Toc24637522][bookmark: _Toc29477132]Figure 9: Search Users Results
[image: ]
[bookmark: _Toc29477087]Delete a Selected User
To delete a user from the User Management list, follow the steps listed below:
1. From the SEOC Admin home page, click Manage Users. The User Management window displays.
From the list of users, select the user that you would like to delete. 
Click Delete Selected User. A message displays confirming that you would like to delete the user.
[bookmark: _Toc29477133]Figure 10: Confirm User Deletion
[image: ]
Click Confirm Deletion. The User will be deleted from the User List and a confirmation message will display.
[bookmark: _Toc29477134]Figure 11: User Deleted Confirmation Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc29477088]Edit a Selected User
To edit a user in SEOC, follow the steps listed below:
1. From the SEOC Admin home page, click Manage Users. The User Management window displays.
1. From the list of users, select the user that you would like to edit.
1. Click Edit Selected User. The Edit User form will display, populated with the selected User information.
[bookmark: _Toc29477135]Figure 12: Editable User Fields
[image: ]
1. Edit the User Name, Role, VA Network ID, and Domain fields as needed.
1. Click Save. The updated user will display in the list of users.
[bookmark: _Toc16600028][bookmark: _Toc24637527][bookmark: _Toc29477136]Figure 13: Updated User displayed in the User List
[image: ]
If any of the fields are not populated, or if VA Network ID or Domain have characters other than letters and numbers, an error message will display when you click Save.
Both the error message and the confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc29477089]Add a New User
To add a new user from the User Management list, follow the steps listed below:
1. From the SEOC Admin home page, click Manage, and select Manage Users. The User Management window displays.
1. Click Add New User. The Add New User form displays.
[bookmark: _Toc29477137]Figure 14: Add New User 
[image: ]
1. In the User Name field, which is required, enter the users name.
1. From the Role menu, which is required, select Viewer, Analyst, Author, Publisher, or Administrator.
1. In the VA Network ID field, which is required, enter the name of the VA network.
1. In the Domain field, which is required, enter the name of the domain. 
1. Click the Save button. The new User will appear in the User List and a confirmation message will display.
[bookmark: _Toc16600026][bookmark: _Toc24637525][bookmark: _Toc29477138]Figure 15: New User Added to the List
[image: ]
If any of the fields are not populated, VA Network ID or Domain have characters other than letters and numbers, or if User Name has a backslash character, an error message will display when you click Save.
Both the error message and the confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc16865671][bookmark: _Toc29477090]Exporting Data
[bookmark: _Toc29477091]Export the SEOC Data to a JSON File
To export the SEOC Data, follow the steps listed below:
[bookmark: _Toc16600029][bookmark: _Toc16865902][bookmark: _Toc29477139]Figure 16: Export Menu: Export SEOC Data
[image: ]
1. As an Analyst, Publisher, or Administrator on the SEOC Admin home page, click Export SEOC Data. A dialog displays indicating the data is being downloaded.
[bookmark: _Toc16600030][bookmark: _Toc16865903][bookmark: _Toc29477140]Figure 17: Export SEOC Data Dialog
[image: ]
If needed, click Cancel on the dialog to cancel the data download.
[bookmark: _Toc16865672][bookmark: _Toc29477092]Export the VA PreCert Webpage Data to a JSON File
For all users who can Export SEOC Data, the SEOC Admin UI also allows them to export the data required for the VA PreCert Webpage.
To export the SEOC PreCert Data, follow the steps listed below:
[bookmark: _Toc16865904][bookmark: _Toc29477141]Figure 18: Export SEOC Data
[image: ]
1. As an Analyst, Publisher, or Administrator on the SEOC Admin home page, click Export PreCert Data. A dialog will appear indicating the data is being downloaded.
[bookmark: _Toc16865905][bookmark: _Toc29477142]Figure 19: Export SEOC PreCert Data Dialog
[image: ]
If needed, click Cancel on the dialog to cancel the data download.
Please refer to Appendix A for additional steps on converting the JSON file into an Excel file.
[bookmark: _Toc29477093]Managing Billing Codes
When updating the Billing Codes, SEOC will go into maintenance mode. SEOC users will be unable to update the system until the Admin has completed managing the billing codes.
Maintenance mode can be turned off by any Admin.
When you click on Return to SEOC list from Billing Code Management, it will automatically turn maintenance mode off.
[bookmark: _Toc16600031][bookmark: _Toc24637532][bookmark: _Toc29477143]Figure 20: Manage Billing Codes in Manage Menu
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To manage the billing codes in SEOC, follow the steps listed below:
1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. The Billing Code Management window displays.
[bookmark: _Toc29477144]Figure 21: Billing Code Management 
[image: ]
This will place the application into Maintenance Mode for all users. While Maintenance Mode is active, users will be unable to save SEOC information or navigate to the User Management Page.


[bookmark: _Toc29477094]Search for a Billing Code
To search for a Billing Code, follow the steps listed below.
1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. The Billing Code Management window displays.
2. From the Billing Code Management page, enter text in the Search by Billing Code field. 
[bookmark: _Toc16600033][bookmark: _Toc24637534][bookmark: _Toc29477145]Figure 22: Billing Code Search Field
[image: ]
3. Press Enter or click the Search button. The table will display all rows where the Billing Code column starts with the text you entered.
[bookmark: _Toc16600034][bookmark: _Toc24637535][bookmark: _Toc29477146]Figure 23: Search Billing Codes Results
[image: ]
[bookmark: _Toc29477095]Deleting Billing Codes
To delete billing codes in SEOC, follow the steps listed below:
1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. The Billing Code Management page displays.
1. From the list of billing codes, select the code that you would like to delete.
1. Click Delete Billing Code. The Confirm Delete Billing Code dialog box will display showing all of the SEOCs that will be affected.
[bookmark: _Toc29477147]Figure 24: Confirm Delete Billing Code Message
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Verify that you want to delete the billing code listed, as the changes will affect the SEOCs listed in the Active and In-Progress tables.
1. Click Confirm. The Billing Code will be deleted from the Billing Codes List. A message will display confirming that that the billing code was deleted and the billing code will no longer display in the list.
For all affected SEOCs with a status of Active, a Revision will be created with the Billing Code deleted. For all affected SEOCs with a status of In-Progress, whether a New SEOC or a Revision, the Billing Code will be removed. For all affected SEOCs with a status of Date Hold, the SEOC will be reverted back to In-Progress and the Billing Code will be removed. Discontinued SEOCs are not affected.
[bookmark: _Toc29477148]Figure 25: Billing Code Deletion Confirmation Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc29477096]Editing Billing Codes
To manage the billing codes in SEOC, follow the steps listed below:
1. From the SEOC Admin home page, click Manage, and select Manage Billing Codes. The Billing Code Management window displays.
1. From the list of billing codes, select the code that you would like to edit.
1. Click Edit Billing Code. The Edit Billing Code form displays, populated with the selected Billing Code information..
[bookmark: _Toc29477149]Figure 26: Edit Billing Code
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1. Update the Billing Code field as needed. The maximum number of characters for this field is 25. 
1. From the Type field, select the correct option: CPT, DRG, HCPCS, HIPPS.
1. Update the Description field as needed. The maximum number of characters for this field is 2,000.
1. From the PreCert Required field, select the correct option: NO or YES.
1. Click Continue. The Confirm Update to Billing Code dialog box will display showing all of the SEOCs that will be affected.
[bookmark: _Toc29477150]Figure 27: Edit Billing Code Confirmation Message
[image: ]
Verify that you want to delete the billing code listed, as the changes will affect the SEOCs listed in the Active and In-Progress tables.
1. Click Confirm. The updated Billing Code will be displayed in the Billing Codes List. A confirmation message will display stating that the edits were made to the billing code.
For all affected SEOCs with a status of Active, a Revision will be created with the Billing Code updated. For all affected SEOCs with a status of In-Progress, whether a New SEOC or a Revision, the Billing Code will be updated. For all affected SEOCs with a status of Date Hold, the SEOC will be reverted back to In-Progress, and the Billing Code will be removed. Discontinued SEOCs are not affected.
If the value of the Billing Code column was not changed as part of the update, the change will not be reflected in Track Version Changes.
It is possible to update a Billing Code without changing any values. When a Billing Code is updated, the previous version is deactivated, and another Billing Code with the updates is used instead. If no values are updated when a Billing Code is saved, the current Billing Code is deactivated, and another is created with the same values.
If any of the fields are not populated, there are any characters in the Billing Code field that are not letters, numbers, a hyphen, or a period, or the Description field has a backslash character, an error message will appear when you click Continue on the Edit Billing Code form.
The error message can be dismissed by clicking the X button.
[bookmark: _Toc16600039][bookmark: _Toc24637540][bookmark: _Toc29477151]Figure 28: Billing Code Saved Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc29477097]Return to SEOC List
To return to the SEOC Admin home page and exit Maintenance Mode, follow the steps listed below.
1. From the Billing Code Management page click Return to SEOC List. The SEOC Admin home page will be displayed, and the application will no longer be in Maintenance Mode.
[bookmark: _Toc16600040][bookmark: _Toc24637541][bookmark: _Toc29477152]Figure 29: Return to SEOC List
[image: ]
[bookmark: _Toc29477098]Exit Maintenance Mode
When the application is in Maintenance Mode, all users will see a notification at the top of the page.
[bookmark: _Toc16600041][bookmark: _Toc24637542][bookmark: _Toc29477153]Figure 30: SEOC Admin in Maintenance Mode
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To exit Maintenance Mode without navigating to the Billing Code Management page, follow the steps listed below.
1. From the SEOC Admin home page, click Turn Off Maintenance Mode. The SEOC Admin home page will update, and the application will no longer be in Maintenance Mode.
[bookmark: _Toc16600042][bookmark: _Toc24637543][bookmark: _Toc29477154]Figure 31: SEOC Admin Not in Maintenance Mode
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[bookmark: _Toc24637028][bookmark: _Toc29477099]Editing Disclaimers
[bookmark: _Toc29477100]Edit the General Disclaimer
All SEOCs share a common General Disclaimer. In the View SEOC Page, Print SEOC Window, and Edit SEOC: Details page, it is displayed as Disclaimer. Publishers and Administrators can access the Edit Disclaimer page which allows the user to update the General Disclaimer for all SEOCs.
Each SEOC also has Additional Information, which can be used to provide SEOC-specific information in addition to the General Disclaimer.
When the General Disclaimer is updated, the change is reflected across all SEOCs instantly without updating version numbers or creating new revisions.
Additional Information is SEOC-specific and requires modifying SEOCs with the usual methods.
To edit the General Disclaimer, follow the steps below:
1. From the SEOC Admin home page, click Edit Disclaimer. The Edit Disclaimer page will display.
[bookmark: _Toc24637545][bookmark: _Toc29477155]Figure 32: Edit Disclaimer Button
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[bookmark: _Toc24637546][bookmark: _Toc29477156]Figure 33: Edit Disclaimer Page
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Make any updates to the General Disclaimer as needed.
Click Save Disclaimer. If there are any invalid characters, a dialog will display. For additional information on invalid characters, refer to the 4.5.6 

Invalid Characters section in this document.
[bookmark: _Toc24637547][bookmark: _Toc29477157]Figure 34: Fix Invalid Characters in General Disclaimer Dialog
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To close the dialog and manually fix the invalid characters, click Cancel.
To save the General Disclaimer and automatically fix the invalid characters, click Save. The invalid characters will be fixed as follows:
\ will be replaced with a space
‘ or ’ will be replaced with '
“ or ” will be replaced with "
• or · will be replaced with *
– or — will be replaced with -
All other characters will be replaced with a space
Regardless of whether there are invalid characters, a confirmation message will display when the General Disclaimer has been saved.
[bookmark: _Toc24637548][bookmark: _Toc29477158]Figure 35: Disclaimer Has Been Saved Message
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The confirmation message can be dismissed by clicking the X button.
Click Return to SEOC List to navigate back to the SEOC Admin UI home page.
For the Edit Disclaimer page, the Return to SEOC List button will not save the General Disclaimer.
[bookmark: _Toc24637029]

[bookmark: _Toc29477101]Deactivate Edit the General Disclaimer
When the description field of the Disclaimer table in the database is set to NULL, the Edit Disclaimer page in the SEOC Admin UI will be inaccessible. The Edit Disclaimer button on the SEOC Admin UI home page will be disabled, and if the user attempts to navigate directly to the Edit Disclaimer page using the browser address bar, they will be redirected back to the SEOC Admin UI home page once the request to fetch the disclaimer is complete. This is similar functionality to what is used to restrict users from accessing pages they do not have the privileges to access.
To reactivate the Edit Disclaimer page in the SEOC Admin UI, set the description field of the Disclaimer table in the database to a value other than null.
[bookmark: _Toc29477102]View SEOCs
[bookmark: _Toc29477103]View a Selected SEOC
To view a SEOC from the SEOC list, follow the steps listed below:
1. From the SEOC Admin home page, select the SEOC you would like to view.
Click View Selected SEOC. The View SEOC page displays.
[bookmark: _Toc29477159]Figure 36: View SEOC
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[bookmark: _Toc29477104]Search for a SEOC by Name
To search for a SEOC, follow the steps listed below:
1. From the SEOC Admin home page, enter the name of the SEOC in the Filter by Name (contains) field. 
[bookmark: _Toc29477160]Figure 37: SEOC Filter Field
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1. Click the Search button. The Search SEOC Results displays.
[bookmark: _Toc29477161]Figure 38: Search SEOC Results
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[bookmark: _Toc16865652][bookmark: _Toc29477105]Sort SEOCs Alphabetically by Name
To sort the list of SEOCs alphabetically by name, follow the steps listed below:
1. From the SEOC Admin home page, select the SEOC Name Column Heading. This will sort the list of SEOCs in alphabetical order by name.
[bookmark: _Toc16865829][bookmark: _Toc29477162]Figure 39: SEOC Name Column Heading
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[bookmark: _Toc16865830][bookmark: _Toc29477163]Figure 40: SEOC List Sorted in Alphabetical Order by Name
[image: ]
To sort the list of SEOCs in reverse alphabetical order, select the SEOC Name Column Heading again.
[bookmark: _Toc16865831][bookmark: _Toc29477164]Figure 41: SEOC List Sorted in Reverse Alphabetical Order by Name
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To return to the default sort order, either refresh the page or click the logo in the upper-right-hand corner of the page.
[bookmark: _Toc29477106]Filter SEOCs by Status
To filter the list of SEOCs by status, follow the steps listed below:
1. From the SEOC Admin home page, select Filter By Status menu.
[bookmark: _Toc29477165]Figure 42: Filter by Status Menu Options
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From the list of options select to filter by: All, Active, Date Hold, Discontinued, or In-Progress. The SEOC list refreshes to display the status filtered by.
[bookmark: _Toc29477107]Discontinue a SEOC
To discontinue a selected Active SEOC, follow the steps listed below:
1. From the SEOC Admin home page, select the SEOC you would like to discontinue.
Click View Selected SEOC, the View SEOC page displays.
Click Discontinue SEOC. The discontinue SEOC confirmation dialog box displays.
[bookmark: _Toc29477166]Figure 43: Discontinue SEOC Confirmation
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Click Confirm Discontinue. The View SEOC page displays with the updated status of the SEOC.
[bookmark: _Toc29477167]Figure 44: Discontinued Status
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[bookmark: _Toc29477108]Print a SEOC
To print a SEOC, follow the steps listed below:
1. From the SEOC Admin home page, select the SEOC you would like to print.
Click View Selected SEOC, the View SEOC page displays.
Click Print SEOC. The printed SEOC will display in another window. Print or save using local browser capabilities.
[bookmark: _Toc29477168]Figure 45: Printed SEOC Window
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[bookmark: _Toc29477169]Figure 46: Printed SEOC (Bottom of the Page)
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[bookmark: _Toc16865663][bookmark: _Ref29377152][bookmark: _Ref29377172]

[bookmark: _Ref29473377][bookmark: _Toc29477109]Invalid Characters
The following business rules for valid characters are enforced in the SEOC Admin UI:
For the Description, Procedural Overview, and Additional Information fields in a SEOC, and the Description field in a Payable Service, the following characters are accepted:
Line Feed (ASCII 10)
Carriage Return (ASCII 13)
The printable ASCII characters (ASCII 32 – 126) except the DELETE character (ASCII 127)
For the SEOC Name, the above characters are accepted except:
& - Ampersand (ASCII 38)
/ - Slash (ASCII 47)
: - Colon (ASCII 58)
\ - Backslash (ASCII 92)
^ - Caret (ASCII 94)
| - Vertical Bar (ASCII 124)
~ - Tilde (ASCII 126)
For a Billing Code value, the following characters are accepted:
Letters
Numbers
- Hyphen (ASCII 45)
. - Period (ASCII 46)
The user will not be able to activate a SEOC unless all of these rules have been followed. In the case of the SEOC Name, the user will be unable to navigate past the SEOC Name and Service Line page of the Create / Edit SEOC Workflow if the SEOC Name has invalid characters. For Billing Codes, the user will be unable to save the Billing Code if the Billing Code value has invalid characters.
The Show Invalid Characters feature allows the user to highlight invalid characters on any SEOC, regardless of status.
[bookmark: _Toc29477110]Show Invalid Characters
To show invalid characters on a SEOC, follow the steps listed below:
1. From the SEOC Admin home page, select a SEOC with invalid characters.
Click View Selected SEOC, the View SEOC page will display.
Click Show Invalid Characters. The Show Invalid Characters page will display.
[bookmark: _Toc16865884][bookmark: _Toc29477170]Figure 47: Show Invalid Characters Button
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[bookmark: _Toc16865885][bookmark: _Toc29477171]Figure 48: Show Invalid Characters
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[bookmark: _Toc24637511][bookmark: _Toc29477172]Figure 49: Show Invalid Characters (Bottom of the Page)
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To print the SEOC with invalid characters shown, click Print SEOC. The Print SEOC page will display with invalid characters shown.
[bookmark: _Toc16865887][bookmark: _Toc29477173]Figure 50: Print SEOC from Show Invalid Characters Page
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[bookmark: _Toc16865888][bookmark: _Toc29477174]Figure 51: Print SEOC from Show Invalid Characters (Bottom of the Page)
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To return to the View SEOC page from the Show Invalid Characters page, click the Hide Invalid Characters button.
[bookmark: _Toc16865889][bookmark: _Toc29477175]Figure 52: Hide Invalid Characters Button
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The Show Invalid Characters button is only available if the SEOC has invalid characters.
[bookmark: _Toc16865664][bookmark: _Toc29477111]Fix Invalid Characters
Invalid characters in a SEOC can either be fixed manually through the Edit SEOC workflow, or automatically with the Fix Invalid Characters feature. Invalid characters are fixed as follows:
|, ^, ~, \, /, and & in the SEOC Name will be replaced with spaces
‘ or ’ will be replaced with '
“ or ” will be replaced with "
• or · will be replaced with *
– or – will be replaced with –
All other characters will be replaced with a space
To automatically Fix Invalid Characters, follow the steps listed below:
1. From the SEOC Admin home page, select a SEOC with invalid characters.
Click View Selected SEOC, the View SEOC page will display.
Click Show Invalid Characters. The Show Invalid Characters page will display.
Click Fix Invalid Characters. The Fix Invalid Characters confirmation dialog will display.
[bookmark: _Toc16865890][bookmark: _Toc29477176]Figure 53: Fix Invalid Characters Button
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[bookmark: _Toc16865891][bookmark: _Toc29477177]Figure 54: Fix Invalid Characters Confirmation
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Click Confirm Fix Characters. A confirmation message will display.
[bookmark: _Toc16865892][bookmark: _Toc29477178]Figure 55: Invalid Characters Fixed Message
[image: ]
This feature is only available for In-Progress SEOCs. For Active SEOCs with invalid characters, create a Pending Revision, then fix the invalid characters.
The confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc29477112]Track Version Changes
To track the version changes of a SEOC, follow the steps listed below:
1. From the SEOC Admin home page, select a SEOC with a previous version.
Click View Selected SEOC, the View SEOC page displays.
Click the Track Version Changes button when it becomes active. The Track Version Changes page will display.
[bookmark: _Toc29477179][bookmark: _Toc16600014][bookmark: _Toc16865878]Figure 56: Track Version Changes Page
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[bookmark: _Toc24637504][bookmark: _Toc16600015][bookmark: _Toc16600016][bookmark: _Toc16865880][bookmark: _Toc29477180]Figure 57: Track Version Changes (Middle of the Page)
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[bookmark: _Toc24637505][bookmark: _Toc29477181]Figure 58: Track Version Changes: Payable Services
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Click the Previous Version button. The changes for the previous version will be shown. If the previous version is the first version of this SEOC, no changes will be displayed.
Click the Next Version button. The changes for the next version will be shown.
Click the Print SEOC button. The Print SEOC page will display with the current changes.
[bookmark: _Toc16600017][bookmark: _Toc16865881][bookmark: _Toc29477182]Figure 59: Print SEOC from Track Version Changes Page
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[bookmark: _Toc24637507][bookmark: _Toc29477183]Figure 60: Print SEOC from Track Version Changes: Additional Information and Provider Taxonomy Codes
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[bookmark: _Toc24637508][bookmark: _Toc29477184]Figure 61: Print SEOC from Track Version Changes: Payable Services
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By default, IE11 will not print the red and green background colors. In order to print the red and green background colors, check the Print Background Colors and Images box in the Page Setup dialog from the Print menu.
[bookmark: _Toc29477113]Draft a New SEOC
To draft a new SEOC, follow the steps listed below:
1. From the SEOC Admin home page, click Draft New SEOC. The Draft SEOC: Name and Service Line window displays.
[bookmark: _Toc29477185]Figure 62: Draft SEOC: Name and Service Line
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Draft New SEOC only applies to the first page in the Create/Edit SEOC workflow. When you navigate to any other page, it will save the SEOC, and thereafter the workflow will be presented as an edit to an existing SEOC.
To return to the SEOC Admin home page while creating a New SEOC, click Return to SEOC List in the bottom left-hand corner of any page in the Create/Edit SEOC workflow. It will not save your changes to the New SEOC.
In the SEOC Name field, enter the name for the new SEOC (required field). The maximum number of characters for this field is 80.
From the Service Line menu, select a service line (required field).
If either the SEOC Name or Service Line are not populated, an error will display when you click Add/Edit SEOC Details.
If the SEOC Name is already being used by another SEOC, an error will display when you click Add/Edit SEOC Details. It is not case-sensitive and it does not take extra spaces into account.
The error message can be dismissed by clicking the X button.
[bookmark: _Toc24637445][bookmark: _Toc29477186]Figure 63: Edit SEOC Menu
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In the footer, you can use the Edit menu to save the SEOC and navigate to any other page in the Create / Edit SEOC Workflow.
You can also click View SEOC to save the SEOC and open the View SEOC page.
The option in the Edit Menu for the current page will be disabled. For instance, in the screenshot above, this is the Edit Name / Service Line page, so that option is disabled, but in any other page in the workflow, it will be available.
For the purposes of this document, the steps will go through all pages of the Create/Edit SEOC Workflow in sequential order, though this is not required in the application.
Select Edit SEOC Details from the Edit Menu. The Edit SEOC: Details page will display.
[bookmark: _Toc16599976][bookmark: _Toc24637446][bookmark: _Toc29477187]Figure 64: Edit SEOC: Details
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[bookmark: _Toc24637447][bookmark: _Toc29477188]Figure 65: Edit SEOC: Details (Middle of the Page)
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[bookmark: _Toc16599977][bookmark: _Toc24637448][bookmark: _Toc29477189]Figure 66: Edit SEOC: Details (Bottom of the Page)
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From the Category of Care drop-down menu, select the Category of Care.
In the Duration (days) field, enter the duration. 
If the value of Duration is not a number between 1 and 365, an error will be displayed if you click Return to SEOC List or View SEOC, or if you navigate using the Edit Menu.
The error message can be dismissed by clicking the X button.
From the QASP drop-down menu, select the QASP.
From the REV drop-down menu, select Yes or No.
In order to activate a SEOC, the REV flag can only be true if at least one Payable Service has a Billing Code that requires Pre-Certification or is set to Any Code Accepted or No Code Required.
In the Description field, enter a description for the procedure.
The maximum amount of characters for the Description field is 2000.
In the Procedural Overview field, enter an overview on the procedure.
The maximum amount of characters for the Procedural Overview field is 5000.
In the Additional Information field, enter additional information regarding the procedure if desired.
The maximum amount of characters for the Additional Information field is 2000.
Disclaimer, above the Additional Information field, refers to the General Disclaimer which is shared across all SEOCs. To update the General Disclaimer, use the Edit Disclaimer functionality found on the front page.
Select Edit SEOC HPTCs from the Edit Menu. The Edit SEOC: SEOC Provider Taxonomy Codes page will display.
[bookmark: _Toc16599978][bookmark: _Toc24637449][bookmark: _Toc29477190]Figure 67: Edit SEOC: Provider Taxonomy Codes
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Click Add new HPTCs to SEOC. The Edit SEOC: Add Provider Taxonomy Codes page will display.
[bookmark: _Toc16599979][bookmark: _Toc24637450][bookmark: _Toc29477191]Figure 68: Edit SEOC: Add Provider Taxonomy Codes
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The navigation buttons in the footer will be disabled while this page is displayed. In order to enable the navigation buttons, click the Done button to return to the previous page.
Enter text in the Filter HPTC table by text field. Press Enter or click the Search button. The table displays all rows with the text you entered in any of the four columns: Provider Code, Grouping, Classification, or Specialization.
Select a Provider Taxonomy Code (HPTC).
Click Add Highlighted HPTC to SEOC. A confirmation message will display.
[bookmark: _Toc16599980][bookmark: _Toc24637451][bookmark: _Toc29477192]Figure 69: Edit SEOC: Provider Taxonomy Code Added Message
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The confirmation message can be dismissed by clicking the X button.
If the selected HPTC has already been added to the SEOC, an error dialog will display when you click Add highlighted HPTC to SEOC.
Repeat steps 16-18 to add additional HPTCs to the SEOC.
When you are finished adding provider codes, click Done. The Edit SEOC: SEOC Provider Taxonomy Codes page will display. The table displays the provider codes you added on the previous page.
[bookmark: _Toc16599981][bookmark: _Toc24637452][bookmark: _Toc29477193]Figure 70: Edit SEOC: Added Provider Taxonomy Codes
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If needed, you can select an HPTC row and click Remove highlighted HPTC from SEOC to remove an HTPC. The Confirm Remove HPTC dialog will display. 
[bookmark: _Toc16599982][bookmark: _Toc24637453][bookmark: _Toc29477194]Figure 71: Edit SEOC: Confirm Remove HPTC
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Click Confirm to remove the HPTC from the SEOC. A confirmation message will display.
[bookmark: _Toc24637454][bookmark: _Toc29477195]Figure 72: Edit SEOC: Provider Taxonomy Code Removed Message
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The confirmation message can be dismissed by clicking the X button.
Select Edit SEOC Payable Services from the Edit Menu. The Edit SEOC: Payable Services page will display.
[bookmark: _Toc16599983][bookmark: _Toc24637455][bookmark: _Toc29477196]Figure 73: Edit SEOC: Payable Services 
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Click Add New Service to SEOC. The Edit SEOC: Add Payable Service section displays at the top of the page.
[bookmark: _Toc16599984][bookmark: _Toc24637456][bookmark: _Toc29477197]Figure 74: Edit SEOC: Add Payable Service
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[bookmark: _Toc24637457][bookmark: _Toc29477198]Figure 75: Edit SEOC: Add Payable Service (Middle of the page)
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[bookmark: _Toc16599985][bookmark: _Toc24637458][bookmark: _Toc29477199]Figure 76: Edit SEOC: Add Payable Service (Bottom of the Page)
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In the Description field, which is required, enter a description for the payable service.
The maximum number of characters for the Description field is 2000.
Under Clinical Services, which are required, select Add Clinical Service. The Edit SEOC: Add Clinical Service dialog box will display.
[bookmark: _Toc16599986][bookmark: _Toc24637459][bookmark: _Toc29477200]Figure 77: Edit SEOC: Add Clinical Service Dialog
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Enter text in the Search for Clinical Service field. Press Enter or click the Search button. The table displays all rows with the text you entered.
Select the desired Clinical Service.
Click Add Clinical Service to Payable Service. A confirmation message will display.
[bookmark: _Toc16599987][bookmark: _Toc24637460][bookmark: _Toc29477201]Figure 78: Edit SEOC: Clinical Service Added Message
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If a Clinical Service is already associated with the Payable Service, an error message will display.
Both the confirmation message and the error message can be dismissed by clicking the X button.
Repeat steps 27-29 to add additional Clinical Services to the Payable Service.
Click Done. The Edit SEOC: Add Payable Service section will display.
[bookmark: _Toc16599988][bookmark: _Toc24637461][bookmark: _Toc29477202]Figure 79: Edit SEOC: New Clinical Services added to the Payable Service
[image: ]
If needed, select a Clinical Service row and click Remove Selected Clinical Service to remove a Clinical Service. A confirmation message will display.
[bookmark: _Toc24637462][bookmark: _Toc29477203]Figure 80: Edit SEOC: Clinical Service Removed Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
In the Allowable Visits / Units field, which is optional, enter the number of allowed visits or other units.
The maximum value for the Allowable Visits / Units field is 999.
In the Frequency (visits/interval) fields, which are optional, enter the frequency of visits and select if it is per week, month, or year.
The maximum value for the Frequency Visits field is 999.
If either the Frequency Visits or the Frequency Interval field is populated without the other, an error will be displayed if you click Done.
The error message can be dismissed by clicking the X button.
If this service does not require billing codes, select No Code Required. A confirmation message will display.
[bookmark: _Toc24637463][bookmark: _Toc29477204]Figure 81: Edit SEOC: No Billing Codes Required Added Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
If you need to remove this and select something else, click Remove Selected Code from Service. A confirmation message will display.
[bookmark: _Toc24637464][bookmark: _Toc29477205]Figure 82: Edit SEOC: No Billing Codes Required Removed Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
If this service can accept any billing code, select Accept Any Code. A confirmation message will display.
[bookmark: _Toc24637465][bookmark: _Toc29477206]Figure 83: Edit SEOC: Any Billing Code Accepted Added Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
If you need to remove this and select something else, click Remove Selected Code from Service. A confirmation message will display.
[bookmark: _Toc24637466][bookmark: _Toc29477207]Figure 84: Edit SEOC: Any Billing Code Accepted Removed Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
If this service requires billing codes, click Add New Billing Code to Service. The Edit SEOC: Add Billing Code dialog box will display.
[bookmark: _Toc16599989][bookmark: _Toc24637467][bookmark: _Toc29477208]Figure 85: Edit SEOC: Add Billing Code 
[image: ]
Enter text in the Search by billing code field. Press Enter or click the Search button. The table will display all rows where the Billing Code column starts with the text you entered.
Select the desired Billing Code.
Click Add Code to Payable Service. A confirmation message will display.
[bookmark: _Toc16599990][bookmark: _Toc24637468][bookmark: _Toc29477209]Figure 86: Edit SEOC: Billing Code Added Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
Repeat steps 40-42 to add additional Billing Codes to the Payable Service.
To define a new Billing Code, click Define New Code. The Define New Code form will display.
[bookmark: _Toc16599991][bookmark: _Toc24637469][bookmark: _Toc29477210]Figure 87: Edit SEOC: Define New Billing Code
[image: ]
If you had entered a billing code in the Search by Billing Code Field before clicking Define New Code, the Billing Code Field will be pre-populated with the value from the Search by Billing Code Field.
If the pre-populated value for the Billing Code Field starts with a letter, the Type menu will default to DRG. Otherwise, it will default to CPT.
In the Billing Code field, which is required, enter the billing code.
The maximum number of characters for the Billing Code field is 25.
From the Type menu, select the type of billing code (required field).
In the Description field, which is required, enter the billing code description.
The maximum number of characters for the Description field is 2000.
From the PreCert Required menu, select whether the billing code requires pre-certification (required field).
Click Add Code to Payable Service. The new code will be added to the current payable service. A confirmation message will display. It will also be available in the list of billing codes in the Add Billing Code dialog box.
If any of the fields are not populated, there are any characters in the Billing Code field that are not letters, numbers, a hyphen, or a period, or the Description field has a backslash character, an error message will appear when you click Add Code to Payable Service.
The error message can be dismissed by clicking the X button.
[bookmark: _Toc16599992][bookmark: _Toc24637470][bookmark: _Toc29477211]Figure 88: Edit SEOC: New Billing Code Added Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
Click Done. The Edit SEOC: Add Payable Service section will display.
[bookmark: _Toc16599993][bookmark: _Toc24637471][bookmark: _Toc29477212]Figure 89: Edit SEOC: Billing Codes added to the Payable Service
[image: ]
If needed, you can select a Billing Code row and click Remove Selected Code from Service to remove a Billing Code. A confirmation message will display.
[bookmark: _Toc24637472][bookmark: _Toc29477213]Figure 90: Edit SEOC: Billing Code Removed Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
Click Done. The Edit SEOC: Payable Services section displays at the top of the page.
[bookmark: _Toc16599994][bookmark: _Toc24637473][bookmark: _Toc29477214]Figure 91: Edit SEOC: Payable Service added to SEOC
[image: ]
If any of the required fields are not populated, or if Allowable Visits/Units or Frequency are not numbers within the specified range, an error message will appear when you click Done.
The error message can be dismissed by clicking X.
If needed, you can select a Payable Service row and click Remove Selected Service from SEOC to remove a Payable Service. The Confirm Delete Payable Service dialog will display.
[bookmark: _Toc16599995][bookmark: _Toc24637474][bookmark: _Toc29477215]Figure 92: Edit SEOC: Delete Payable Service Confirmation
[image: ]
Click Confirm Deletion to remove the Payable Service. A confirmation message will appear.
[bookmark: _Toc24637475][bookmark: _Toc29477216]Figure 93: Edit SEOC: Payable Service Removed Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
You can also select a Payable Service row and click Edit Selected Service to edit the selected Payable Service.
Click View SEOC. The information you entered will be displayed, including Provider Taxonomy Codes (HPTCs) and Payable Services. The In-Progress (New) status will display in the window.
[bookmark: _Toc16599996][bookmark: _Toc24637476][bookmark: _Toc29477217]Figure 94: Edit SEOC: View SEOC
[image: ]
[bookmark: _Toc16599997][bookmark: _Toc24637477][bookmark: _Toc29477218]Figure 95: Edit SEOC: View Provider Taxonomy Codes and Payable Services
[image: ]


[bookmark: _Toc29477114]Edit an In-Progress SEOC 
If a user attempts to edit a SEOC that another user is already editing, the user will receive a message stating that the request can’t be processed.
If a user attempts to edit a SEOC while the system is in maintenance mode for Billing Code Management, the user will receive a message stating that the request can’t be processed.
To edit a SEOC that is currently marked as In-Progress, follow the steps listed below:
1. From the SEOC Admin home page, select the SEOC you would like to edit.
Click View Selected SEOC, the View SEOC page displays.
Click EDIT SEOC. The Edit SEOC: Name window displays.
Follow the workflow in the previous section to edit any fields as necessary.
Click View SEOC to confirm the edits.
[bookmark: _Toc29477115]Activate an In-Progress SEOC
To activate a SEOC that is currently marked as In-Progress, follow the steps listed below:
1. From the SEOC Admin home page, select the SEOC you would like to activate.
Click View Selected SEOC, the View SEOC page displays.
Click Activate SEOC. 
Once the SEOC is activated, the previous version status is automatically set to Discontinued.
If there are activation errors, the Activation Error dialog will display listing what needs to be resolved before the SEOC can be activated.
[bookmark: _Toc29477219]Figure 96: SEOC Activation Errors
[image: ]
If there are no activation errors, the Confirm Activation dialog displays.
[bookmark: _Toc29477220]Figure 97: SEOC Activation Confirmation
[image: ]
The Effective Date will default to the next day at 12:01AM EST. If needed, enter a new Effective Date in the input or click the calendar icon to select a date.
[bookmark: _Toc29477221]Figure 98: SEOC Activation Confirmation Calendar
[image: ]
Click Confirm Activation. A confirmation message will display. The Date Hold status will display in the upper-right-hand corner of the page.
The SEOC will remain in Date Hold status until 12:01AM EST on the specified Effective Date. At that time, the SEOC will change to Active status.
[bookmark: _Toc29477222]Figure 99: SEOC Will be Activated Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
Click Return to SEOC List to see the SEOC in the list with a Date Hold status.
[bookmark: _Toc29477116]Delete an In-Progress SEOC
To delete a SEOC that is currently marked as In-Progress, follow the steps listed below:
1. From the SEOC Admin home page, select the draft SEOC you would like to delete.
Click View Selected SEOC, the View SEOC page displays.
Click Delete SEOC. The Confirm Deletion dialog box displays.
[bookmark: _Toc29477223]Figure 100: Confirm Deletion 
[image: ]
Click Confirm Deletion. The SEOC is deleted from the SEOC List.
[bookmark: _Toc29477117]Pending Revisions
[bookmark: _Toc29477118]Create a Revision
To create a revision to an existing SEOC, follow the steps listed below:
1. From the SEOC Admin home page, select the active SEOC you would like to create a pending revision.
Click View Selected SEOC, the View SEOC page displays.
Click Create Pending Revision. The Revision: Name and Service Line window displays.
[bookmark: _Toc29477224]Figure 101: Revision: Name and Service Line
[image: ]
To return to the SEOC Admin home page while editing a new SEOC or Revision, click Return to SEOC List in the bottom left-hand corner of any page in the Edit SEOC workflow.
Update the SEOC Name and Service Line as needed.
Click Add/Edit SEOC Details. The Revision: Details window displays.
[bookmark: _Toc29477225]Figure 102: Revision: Details
[image: ]
[bookmark: _Toc24637489][bookmark: _Toc29477226]Figure 103: Revision: Details (Middle of the Page)
[image: ]
[bookmark: _Toc16600006][bookmark: _Toc24637490][bookmark: _Toc29477227]Figure 104: Revision: Details (Bottom of the Page)
[image: ]
Update the details for the SEOC as needed.
Click Add/Remove HPTCs. The Revision: SEOC Provider Taxonomy Codes window displays.
[bookmark: _Toc29477228]Figure 105: Revision: SEOC Provider Taxonomy Codes
[image: ]
Update the Provider Taxonomy Codes (HPTCs) for the SEOC as needed.
Click Add/Edit Payable Services. The Revision: Payable Services window displays.
[bookmark: _Toc29477229]Figure 106: Revision: Payable Services
[image: ]
1. Select a Payable Service.
1. Click Edit Selected Service. The Edit Payable Service section will display.
[bookmark: _Toc24637493][bookmark: _Toc29477230]Figure 107: Edit Payable Service
[image: ]
[bookmark: _Toc24637494][bookmark: _Toc29477231]Figure 108: Edit Payable Service: Billing Codes
[image: ]
[bookmark: _Toc24637495][bookmark: _Toc29477232]Figure 109: Edit Payable Service: Billing Codes and Action Buttons
[image: ]
[bookmark: _Toc24637496][bookmark: _Toc29477233]Figure 110: Edit Payable Service: Payable Services List
[image: ]
1. Make any desired updates
1. Click Done. The Revision: Payable Services page will display.
1. Repeat steps 10-13 for the other Payable Services as needed.
1. Click View SEOC. The In-Progress (Revision) status will display in the window.
[bookmark: _Toc16600009][bookmark: _Toc24637497][bookmark: _Toc29477234]Figure 111: In-Progress (Revision) Status
[image: ]
1. Click Return to SEOC List. The Revision will display in the list of SEOCs.
[bookmark: _Toc16600010][bookmark: _Toc24637498][bookmark: _Toc29477235]Figure 112: Revision Displayed in SEOC List
[image: ]
[bookmark: _Toc29477119]Activate a Revision
To activate a pending revision, follow the steps listed below:
1. From the SEOC Admin home page, select the Revision SEOC that you would like to activate.
1. Click View Selected SEOC, the View SEOC page displays.
1. Click Activate SEOC. If there are activation errors, the Activation Error dialog will display listing what needs to be resolved before the SEOC can be activated.
[bookmark: _Toc16865873][bookmark: _Toc29477236]Figure 113: Revision Activation Errors
[image: ]
1. The Revision Activation Confirmation message displays.
[bookmark: _Toc29477237]Figure 114: Revision Activation Confirmation Message
[image: ]
1. The Effective Date will default to the next day at 12:01AM EST. If needed, enter a new Effective Date in the input or click the calendar icon to select a date.
[bookmark: _Toc16600012][bookmark: _Toc16865875][bookmark: _Toc29477238]Figure 115: Revision Activation Confirmation Date Calendar
[image: ]
1. Click Confirm Activation. A confirmation message will display. The Date Hold Status will display in the upper-right-hand corner of the page.
[bookmark: _Toc29477239][bookmark: _Toc16865876]Figure 116: Revision Will be Activated Message
[image: ]
1. Click Return to SEOC List. The pending revision that you just activated will display as Date Hold in the list of SEOCs.
The Revision will remain in Date Hold status and the previous SEOC will remain in Active status until 12:01 AM EST on the specified Effective Date. At that time, the Revision will change to Active status and the previous SEOC will change to Discontinued status.
[bookmark: _Toc16865658][bookmark: _Toc29477120]Revert a Date Hold SEOC Back to In-Progress
If you need to revert the selected SEOC to In-Progress, follow the steps listed below:
1. From the SEOC Admin home page, select the Date Hold SEOC you would like to revert back to In-Progress.
1. Click View Selected SEOC, the View SEOC page displays.
1. Click Revert SEOC to In-Progress. The Confirm Revert SEOC to In-Progress dialog will display.
[bookmark: _Toc29477240]Figure 117: Confirm Revert SEOC to In-Progress
[image: ]
1. Click Confirm. The SEOC will be reverted back to In-Progress and a confirmation message will display.
[bookmark: _Toc24637484][bookmark: _Toc29477241]Figure 118: SEOC Reversed to In-Progress Message
[image: ]
The confirmation message can be dismissed by clicking the X button.
[bookmark: _Toc29477121]Troubleshooting
Users may encounter the following errors while using the SEOC UI. 
Table 2: SEOC Error Codes with Descriptions
	Error Code
	Description

	204
	No Content Found

	401
	Unauthorized

	403
	Forbidden

	404
	Not Found


[bookmark: _Toc29477122]Acronyms and Abbreviations
	[bookmark: _Hlk508800414]Acronym
	Definition

	CAC
	Clinical Application Coordinators

	CC
	Care Coordination

	CCAD
	Community Care Agile Development

	CDW
	Corporate Data Warehouse

	CID
	Clinically Indicated Date

	CPRS
	Computerized Patient Record System

	HEC
	Health Eligibility Center

	HPTC
	Healthcare Provider Taxonomy Code

	JSON
	JavaScript Object Notification

	NSD
	National Service Desk

	OIT
	Office of Information and Technology

	PCP
	Primary Care Physician

	SAR
	Secondary Authorization Request

	SEOC
	Standardized Episode of Care

	VA
	Department of Veterans Affairs

	VDL
	VA Software Document Library

	VistA
	Veterans Health Information Systems and Technology Architecture




[bookmark: _Toc29477123]JSON Instructions
The steps outlined below are for Excel 2016.
To convert the SEOC JSON file to an Excel file, follow the steps listed below:
1. Select to download the SEOC JSON file. The Internet Explorer File Download Prompt displays at the bottom of the window.
1. From the Save menu, select Save as. The Save As window displays.
1. Select to download the file to the Desktop and click Save.
Open a blank workbook in Excel 2016.
Click the Data tab, then Get Data > From File > From JSON. The Import Data window displays.
[bookmark: _Toc29477242]Figure 119: Import Data Window
[image: ]
Select the JSON file you downloaded and click Import. Excel will open the file in the Query Editor.
[bookmark: _Toc29477243]Figure 120: Query Editor
[image: ]
Click the List header to the right of Seocs to display a list of records.
[bookmark: _Toc29477244]Figure 121: List of Records
[image: ]
From the Transform tab, click the Convert To Table icon and click OK. The To Table dialog box displays.
[bookmark: _Toc29477245]Figure 122: To Table Dialog Box
[image: ]
From the To Table dialog box keep the default selections and click OK.
[bookmark: _Hlk533765398]Click on the expand icon (<-||->) to the right of the Column1 header to display the Search Columns to Expand dialog box.
[bookmark: _Toc29477246]Figure 123: Search Columns to Expand Dialog Box
[image: ]
De-select the Use original column name as prefix check box.
Click OK.
Click on the expand icon (<-||->) to the right of the Seoc header to display the Search Columns to Expand dialog box.
[bookmark: _Toc29477247]Figure 124: Search Columns to Expand
[image: ]
Uncheck the Use original column name as prefix check box.
Click OK. The fields in the SEOC table will be expanded to columns as shown below.
[bookmark: _Toc29477248]Figure 125: Expanded SEOC Fields
[image: ]
Scroll right to the services column, click on the expand icon, and select Expand to New Rows to display the records.
[bookmark: _Toc29477249]Figure 126: Expand to New Rows Menu Option
[image: ]
Click the expand icon again and press OK to expand the Payable Services fields into columns.
[bookmark: _Toc29477250]Figure 127: Payable Services Columns
[image: ]
Scroll right to the billingCodes column and repeat the last two steps to expand the Billing Code fields into columns.
[bookmark: _Toc29477251]Figure 128: Billing Code Columns
[image: ]
Optional - Repeat the last two steps again for the serviceHptcs column if you want to see the cross-walked HPTCs that are sent for each Payable Service.
Scroll right and repeat the last two steps again for the hptcs column to expand the HPTC fields that were assigned to each SEOC. 
[bookmark: _Toc29477252]Figure 129: Expanded HPTC Fields
[image: ]
Click the Close & Load option at the left of the ribbon to create load the imported data into a spreadsheet tab.
[bookmark: _Toc29477253]Figure 130: Imported Data
[image: ]
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